
Adobe Photoshop Elements 10:
Adjusting Images for the Web 

Activity Guide

Adobe Photoshop Elements is a consumer level image editing program modeled after Adobe Photoshop. 
Like Photoshop, it contains powerful image editing capabilities and many of the features photo editing en-
thusiasts want. But rather unlike Photoshop, Elements makes it easy for beginning and novice photo editors 
to get started editing and manipulating images and develop their skills. This is due in large part to Elements’s 
user-friendly features, many of which streamline complex image editing processes.

This guide accompanies a short course covering the following topics: (1) scanning images, (2) workspace and 
toolbar, (3) resolution and sizing, (4) selection and cropping, (5) adjusting images, (6) adding text, (7) batch 
processing, and (8) saving for the web.

1. Scanning Images
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To scan an image in Elements, click File, then Import, and then choose the scanner software connected to 
your specific computer. This calls up an external module with options designated by your scanner. Consult your 
scanner documentation for more information about these options.

Usually, you can use this method to scan an image directly into Elements. Sometimes, however, (i.e. if your 
scanner is not listed under Import) you will need to open your scanner software, scan the image and save it, 
and then open the image in Elements to work with (File > Open > [image filename]). 

Image Import Tips:
•	 Scan the largest, highest quality version of the 

image you can find. Images printed in maga-
zines and books do not necessarily represent 
high quality originals, and often the quality of 
the paper is not conducive to high resolution 
scans.

•	 Consider your image’s eventual output and 
scan it using at least twice the resolution re-
quired. For example, if you are scanning an  
image for use on the web with an eventual out-
put of 72 ppi (pixels per inch), then you might 
scan at 180 ppi . This will allow you to manipu-
late the image without risk of pixilation.



All materials © Faculty Development Institute, Virginia Tech, 2012. All rights reserved.

2. Workspace and Toolbar
In Photoshop Elements, when you select a tool 
from the main toolbar (A) on the left-hand side, 
the options for that tool appear across the top 
of the screen (B). Elements has three editing 
modes (C), which are discussed in greater de-
tail in Section 5: “Adjusting Images.” Below the 
editing modes and their corresponding palettes 
is the layers palette (D). Layers are images or 
effects laid overtop each other that you can 
manipulate, allowing for flexible editing. At the 
bottom of the workspace is the project bin (E) 
that displays the images currently open. Dou-
ble-click on an image to bring it into the editing 
window (F).
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Below is an overview of each of the 
tools in the Elements toolbar in Full edit 
mode. If a tool has a black arrowhead in 
its bottom right corner, double-click on it 
or click and hold to see its other options.

1:  Move - Move a selection 

2:  Zoom - View image close up or far      	
      away 
	
3:  Hand - Move selection around the       	
      page 

4:  Eyedropper - Copy color from one  
      area, drop it in another

5:  Rectangular/Elliptical Marquee - 
      Select rectangle or oval shapes

6:  Lasso - Select irregular shapes
	 Regular - Freehand
	 Magnetic - System-sought anchor 	
	 points (click and drag)
	 Polygonal - Choose anchor points 	
	 by clicking

7:  Magic Wand - Select pixels within a 
      similar color range

8:  Quick Selector - Select pixels of similar 
      color and texture

9:  Type - Insert text (see Section 6)

10:  Crop - Remove an unselected part of  
        an image

11:  Cookie Cutter - Crop specific shapes

12:  Straighten - Straighten a crooked image

13:  Red Eye Remover

14:  Spot Healing Brush - Remove spots or 
        larger areas of an image

15:  Clone Stamp - Copy pixel area and apply it 
        elsewhere

16:  Eraser - Erase part of an image, 
        background, or area within a color range

17:  Brush/Pencil - Draw brush/pencil strokes
        Color Replacer - Paint with foreground  
        color without covering image detail

18:  Smart Brush - Select area of image and 
        apply adjustment to it

19:  Paint Bucket - Fill selection with 
        foreground color

20:  Gradient - Fill selection with gradient of 
        foreground and background colors

21:  Shapes - Draw shapes onto image

22:  Blur/Sharpen/Smudge
 
23:  Sponge - Saturate/desaturate pixels  	
        where you paint
        Dodge - Lighten pixels where you paint
        Burn - Darken pixels where you paint

24:  Color Picker - Select a primary 
        (“foreground) and secondary 
        (“background”) color to use
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3. Resolution and Sizing

To access image resolution and sizing options, 
click Image, then Resize, and then choose either 
Image Size or Canvas Size.

•	 Image Size controls the size of the image 
itself.

•	 Canvas Size controls the size of the canvas 
under the image. (For example, you can make 
the canvas larger than the image, leaving 
room to add additional content to the original 
image. Changing the canvas size also allows 
you to create a border around your image.)

Image Size

Under “Pixel Dimensions,” the image size is listed in 
number of pixels horizontally and vertically. You can 
resize the image by changing the number of pixels 
listed by Width and Height. If you wish to resize the 
image to a percent of its current size, you can do so 
by changing the scale from pixels to percent using 
one of the dropdown menus and entering the desired 
percentage. (Note: You will not be able to change the 
image size unless “Resample Image” at the bottom of 
the menu is checked.)

Under “Document Size,” you can change the size of 
the document as well as the units in which the docu-
ment size displays (e.g., percent, inches, cm, mm, 
points, picas, or columns) the same way as with the 
image size. You can also change the resolution--or the 
sharpness and clarity of the image--which is deter-
mined by the number of pixels per inch (or cm) of the 
image.

Resolution Values to Remember:
•	 72 pixels/inch for the web
•	 300 pixels/inch for print

When “Constrain Proportions” is checked, you can 
change only the width or height of the image and the 
other will resize automatically to maintain the locked 
proportions. The boxes that are joined with the chain 
icon will maintain relative values. Unchecking “Con-
strain Proportions” will allow you to resize width and 
height independently of each other.
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4. Selection and Cropping
Selecting parts of images and cropping images are two related processes. “Cropping” images is the term for 
selecting a part of an image and then discarding the rest. There are several ways to crop an image. The most 
straightforward way to crop an image is with the crop tool:

Crop Tool - Select a portion of the image by dragging a rect-
angle over it. Hit the Enter key or click the Accept button to 
disgard that which is not contained within the rectangle.

There are several more nuanced techniques for selecting portions of and cropping images. They are as follows:

Marquee Tool - Select a rectangular or ovular portion of the image.

Lasso Tool - Select a non-regular shape either freehand, by selecting along 
natural divisions with the “magnetic” lasso, or using straight lines with the 
“polygonal” lasso.

Quick Selector Tool - Select a specific color and texture set within the image. 
(This tool is the most efficient way to select a specific object in an image, and 
it affords a good amount of control. In the options bar at the top, you can 
choose a brush size and use the “+” and “-” features to add or subtract areas 
of a selection.)

The selected part of the image is in-
dicated by a blinking, dotted outline. 
To remove any part of the image that 
is not selected, click Image, and then 
choose Crop. (In other words, after 
cropping, all that you will have left 
will be the part of the image you have 
selected.)

You can also copy a selected area into 
another Elements document and save 
it as a new file. Copy the selected area 
(Edit>Copy) and select File>New>Image 
from Clipboard.

To invert the selected part and the unselected part (which can be use-
ful if you want to crop out the background and the foreground is easier 
to select), click Select, and then choose Inverse.
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•	 Full - The most similar to the Professional Adobe 
Photoshop, minus several of the tools. It is usually 
the default setting in which you can access the full 
set of tools in the left bar as well as effects, addable 
content, and the layers palette in the right-hand 
column.

The following are some popular tools that can be found in the 
Quick edit left-hand toolbar:

Red Eye Removal - Removes red eye (or green/white 
eye in pets) in photos taken with a flash. Click on the 
center (pupil) of the eye you want to fix, or click the 
Auto button in the options bar.

Whiten Teeth - Brightens teeth to make them appear whiter. Drag within the image area that con-
tains the teeth you want to whiten.

Make Dull Skies Blue - Modifies the color of the sky to a more vivid hue. Drag within the image 
where you want to make the sky appear bluer. This applies a blue gradient to the selected area. 
Adjust levels (especially saturation) for the entire photo to make the effect appear more natural.

Black and White - High Contrast - Simulates the image effects that photographers produce when 
placing a red filter over the camera lens and using black and white film. Drag within the image area 
that you want to convert to high-contrast black and white.

5. Adjusting Images
Elements has three editing modes accessible on the left-
hand column (see C in Section 2):

•	 Quick - Provides easy-to-use slider controls in the right-hand column for some of the most popular edit-
ing functions, including adjustments in lighting and color as well as sharpening. You can enhance parts of a 
photo by selecting them with the Quick Selection tool while in this mode. It also provides some automatic 
fixes in the (right-hand) toolbar.  

•	 Guided - For novices, provides easy-to-use “wizards” with step-by-step instructions for many editing  
functions and certain project functions such as Photo Merge and Face Merge.
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Removing parts of an image (“Retouching) in Full mode:

•	 Spot Healing Brush Tool - Choose a brush size and 
paint over the area you wish to remove. For best re-
sults, ensure that“Content-Aware” is selected and use 
on an area with a consistent background. 

•	 Clone Stamp Tool - Manually select an area (ALT+click) 
and paint over the undesired element with the select-
ed area’s information. This takes practice but is useful 
for complicated areas that the automatic Spot Healing 
Brush does not know how to interpret.

6. Adding Text

Type Tool - There are a variety of ways to add text to an image in Elements. In each typing mode, you can make 
modifications (e.g. font, style, size and justification of the text, etc.) in the options bar at the top. The options 
displayed depend on the typing method you choose. To choose a particular method of typing, right click on the 
Type tool. You will have the following options:

•	 Horizontal/Vertical Type Tool - These type 
tools are the most basic and commonly used. 
They allow you to type text on a horizontal or 
vertical line. Click on the image to set an inser-
tion point (for a single line of text) or drag a 
rectangle to create a text box (for more than 
one line of text). 

•	 Horizontal/Vertical Type Mask Tool - Allows 
you to remove part of the image in the form 
of the text (type text, adjust font/size/posi-
tion, and hit Delete on your keyboard) and/or 
contain part of the image within the text (type 
text, adjust/font/size/position, and copy/paste 
as new file). Below is an example of the latter: 

•	 Text on Selection Tool - Allows you to type along a 
selected area. When you click the tool, it gives you 
a Quick Selection tool with which to select the area 
you want to type along. Accept the selection and 
click on the solid-line selection to place your cursor 
and start typing. 
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7. Batch Processing
Elements allows you to apply certain processes to a group of images simul-
taneously. You can access the batch processing menu by clicking File and 
then choosing Process Multiple Files.

Here, you have options 
for choosing the source 
and destination of your 
group of images, choos-
ing a system for naming 
them, resizing them and 
adjusting their resolu-
tion, coverting them to a 
different file type, making 
automatic adjustments, 
and labeling them.

•	 Text on Shape Tool - Allows you to type along a shape that you choose from the dropdown menu in the  
options bar. Create a new layer and draw the shape, then hover over the lines until you see a cursor and 
click where you want to begin typing. 

•	 Text on Custom Path Tool - Allows you to type along a path that you draw. Create a new layer and draw a 
path for the text to take. Click on the path to access the points you can use to refine the path. When you 
are satisfied with the path, commit it by clicking the green check box. Hover over the path until you see a 
cursor appear and click where you want to start typing your text.

For the Text on Selection, Text on Shape, and Text on Custom Path tools, please note the following:
•	 You should avoid typing on areas with sharp angles, as the text will not be readable
•	 When your type is inserted, hold “Command” (Mac) or “Control” (PC) on your keyboard as you hover over 

a small dot on the line and click and drag to move the text along the path
•	 When you are dragging the text along the path, you can also move it to the other side of the path by drag-

ging in the direction of the little black arrow
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In this menu, the left-hand image displays your origi-
nal file above its size. The right-hand side displays a 
preview of your image configured for the web. The 
download time is set to 28.8 Kbps (Kilobytes per 
second). In the palette on the far right of the menu, 
there is a drop-down menu that will allow you to 
choose various settings for saving your file. You can 
adjust the quality of the image to affect its download 
time. 

8. Saving Images for the Web
When saving images for use on the web, the main factor to keep in mind 
is file size. File size is determined by a combination of factors, including 
the number of colors in the image, the image dimensions, the value of 
the resolution, and the file format in which the image is saved. In order 
to reduce download times for your web images, you will want to reduce 
these factors.

Oftentimes, the number of colors in the image is not individually control-
lable. However, the file format that you choose for your image has an 
impact on the number of colors available in the image. For instance, .gif 
files only use a basic set of 64 colors, while .jpg supports over 2 million. 
Elements makes it easy to decide which file format and settings would be 
best for your web image. When you have your image ready, click File, and 
then choose Save for Web.

Notes on File Types
•	 PSD – (Photoshop file) won’t display on a web page, can only open in photoshop, includes aspects unique to Photoshop (layers)
•	 JPG/JPEG – [web image file (photographs)] most common format for web use and digital sharing, compressed image (doesn’t 

noticeably detract from image quality), can be degraded in quality when repeatedly edited and saved
•	 PNG – [web image file (illustrations)] successor to the GIF, supports way more colors (16 million instead of 256), good for editing 

photos (larger, whereas JPG good for distributing), supports transparency
•	 TIF/TIFF – (printing file format) flexible format but that isn’t widely support web browsers, widely accepted as standard in 

printing business


